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This instruction manual provides the necessary information for safe and efficient use of the product
throughout its life cycle.

Representational tools

Font markup bold: clickable areas in the software GCT.
Font markup italic: windows and views to navigate to in the software GCT.

History 

Version 1.0.0

The initial version of this Documentation is July 2023. 

Offline/Old versions 

GCT 2.3
Download the Manual for GCT Version 2.3.

About this instruction manual
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The GenICam Control Tool (GCT) permits communication with cameras that fulfill the GenICam standards. The tool

allows one to set up a camera, browse and adjust parameters, perform camera calibration tasks, and visualize and

analyze acquired images.

The following graphic shows an overview of the connection between the GCT software and the camera. The host

software uses the CSGenICam SDK to connect to the camera. Regarding the GenIcam GenTL standard, the

software and your program are interface-independent. The only difference is that the appropriate transport layer

should be used for each interface type. This means if you are using a GigE camera, you need a network adapter and

the s2i or Kithara transport layer, if you want to use a CoaXPress camera you need a frame grabber and the

CoaXPress transport layer (delivered from the frame grabber vendor).

Overview

Camera

Host software

CSGenICam

SDK 3rd party software:

HALCON (MVTec)

Common Vision Box (Stemmer)

Transport layer

and

interface

s2i Kithara

GigE

CXP

CXP

CXP CameraGigE C amera

XMLXML
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The device is designed for machines and systems which are used for commercial and industrial
applications.
The device is designed for contactless optical detection of primarily two dimensional objects.
The device may only be connected or used as described in this manual.
Do not use the device in safety relevant control circuits and potentially explosive environment.

Intended use
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XLC4

1 5 6

2

9

7

3

4

1 Line scan camera: Scans the image line by
line and communicates with the PC.

2 Optical system: Lenses and mounts

3 Illumination: Lights up the information
carrier/scan area.

4 Illumination controller: Controls and monitors
the illumination unit.

5 Cables and suitable network card or frame
grabber in the PC:
The image data are sent to a PC.

6 PC: The PC performs subsequent processing
of the image data and can optionally control
the illumination system.

7 Speed detection: The speed of the
object/conveyor belt can be detected by an
optional incremental encoder. The encoder
can be connected to the camera.

8 Conveying unit: Moves the scanned object.

9 Frame trigger: A light barrier can be used to
detect the object and start the image
acquisition on time. The frame trigger can be
connected to the camera.

Line scan system
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Hardware requirements:

TKH Vision GenICam-standard camera
Intel Core i7 or higher
16GB RAM or higher
Min. PCIe 3.0 lane with min. 8 lanes to install your frame grabber or network card

Software requirements:

Win10 x64 bit operating system
Driver for 10-Gigabit Ethernet network interface card or frame grabber software

System Requirements
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To install the GCT software for Windows: 

1. Download the installer from our homepage. 
2. Install the NIC-10GigE-Driver Files, please refer to Network adapters and transceivers.
3. Connect the camera to the PC and turn it on. 
4. Start the GCT installer and follow the instructions.
5. At the window Select Components: Select the Full installation , if you want to install Kithara or use

the Installation for GigE & CXP if you only need the s2i TL.

6. For Kithara a License Dongle is required

7. During installation, you will be asked if you want to configure the GigE network adapters, if you
are using a network adapter with an Intel chipset, you should answer with Yes

1. The command line window lists all available ethernet adapters and you can configure the network

adapter by entering a Y into the script. Now the script setup your network card.

2. For each adapter, you will be asked in the script. 

Installation GigE

Note GigE Transport Layer 

GCT delivers two different Transport Layers (TL) in the installer. You can decide between the s2i TL and the Kithara TL.
For a real-time application with high frame rates, it is recommended to use the Kitahra TL. Furthermore, it is
recommended to set up your system with the s2i TL and if necessary activate the Kitahra TL later on.
With this installation, you can also connect a CXP camera with GCT

For the allPixa neo and a Broadcom network adapter, you can use the s2i TL.
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8. After the configuration of the network parameter, the script can help you to set a static IP Address of
the network adapter. We recommend disagreeing by entering N into the window. If you want to set

a static IP Address for your network, you can answer with Y.
9. Restart the PC

10. If you want to use Kithara please configure Kithara after the restart. To set up Kithara, please follow

the instructions 10 GigE with Kithara transport layer. 

Note 

If an error occurs during the execution of the script you have to configure the network
adapter manually. 
Make sure that the parameters of your network adapter are set correctly. For more
information, see Configure the network adapter.
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To install the GCT software for Windows: 

1. Download the installer from our homepage. 
2. Install your Framegrabber software

3. Start the GCT installer and follow the installation instructions.
4. At the window Select Components: Select the Compact installation for a CXP camera.

 
5. After the installation please restart your PC. 

Installation CXP

Note 

The connection between the CXP camera and GCT is done with a transport layer from the frame grabber vendor. For
the driver of the CoaXPress frame grabber as well as the transport layer, please follow the instructions of the grabber's
manufacturer.
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The software provides different panel elements, they can be placed, resized, and docked freely within GCT window.

The GCT user interface starts after a successful connection with your camera. The window contains four main areas.

The Menu bar widget for general access, the Toolbar widget for fast access to the most common functions, the

image view widget where the image and all relevant information’s are displayed and the configuration widget for the

camera configuration.

Menu Bar

The Start Menu offers the following functions:

Connect/Disconnect: Opens device discovery widget or disconnect the camera, see
Start Grabbing: Starts continues image grabbing
Device description: Load and save xml file from the camera
Settings: GCT setting options, see
Exit: Close GCT window

The Tools Menu offers the following functions

Calibration: Opens a camera calibration dialog, Creating a black-reference (DSNU) and Creating
a shading-reference (PRNU)

Maintenance Mode: Only for experts
Up/Download: Opens a Up/Download dialog, see
Register Editor: Only for experts
Kithara Configurator: Opens the Kithara Network Configurator, see

The View Menu offers the following functions

Default view: Set the GCT view to default
Camera Configurations: Shows the configuration panel in the configuration widget
Message Log: Display the Message Log under the Image view

Overview
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Refresh Feature Tree: Refreshes the feature tree

The Help Menu offers the following functions

About: General Information’s about GCT
Open GCT Manual: Opens the GCT Manual
System Information: Generates a System information report
Search for GCT Update: Search for GCT updates

Toolbar widget

The Toolbar widget contains the following icons and their functions.

The Toolbar widget offers the following button functions:

Connect/Disconnect: Opens device discovery widget or disconnect the camera, see
Reset and reconnect: Resets the camera and reconnect
Start Grabbing: Starts continues image grabbing
Abort Grabbing: Stops the image acquisition
Acquire a single frame: Acquires a single frame
Load image: Load an image from disk
Save image: Save image to disk

Conf iguration widget

The Configuration widget provides two panels, Camera features which is the GenIcam parameter tree and the

configuration panel which is a graphical representation of the GenIcam parameter tree.

The following image shows the configuration panel of the configuration widget. The panel contains a tab view, from

which four main categories can be selected. Each tab contains another tab view with subcategories. The content in

each sub tab view is scrollable.

An Info box or tooltip is shown when hovering over a parameter input field or the blue information icon.
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The Camera Features tab contains the GenIcam parameter tree, the user setup level and an extra panel to set up the

filter driver.
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Image view widget

The image view widget shows the current image view and additional image and stream relevant information’s.
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Line plot view

GCT2 can display a horizontal line plot in the image view widget. To add this feature, add a new tab, therefore press

the plus on the top. A popup window will be open, please select under the “View Type” the “Horizontal Line plot.

After this configuration a new window will open as shown in the following figure.
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Histogram view

GCT2 can display a histogram of in image content in the image view widget. To add this feature, add a new tab,

therefore press the plus on the top. A popup window will be open, please select under the “View Type” the

“Horizontal Line plot.

After this configuration a new window will open as shown in the following figure.
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Arrange / Rearrange widgets

The software provides different widget elements, they can be placed, resized, and docked freely within GCT window.

If you are using two monitors you can place, for example, the configuration widget on the second screen and the

image view widget on the first screen.

GCT2 manual  Vers ion 1.0.0, Date 15.09.2023

Page: 19 



The software provides different widget elements, they can be placed, resized, and docked freely within GCT window.

If you are using two monitors you can place, for example, the configuration widget on the second screen and the

image view widget on the first screen.
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To be able to access the camera, GCT needs to create a connection to the camera and to download an
XML file that specifies the camera interface.

Connecting the camera

1. Switch on the camera. Initialization can take up to about 40 seconds.
2. Start GCT.
3. On the toolbar click Run device discovery.

The Discovery dialog box opens and the Discovered Devices list shows information about the detected
camera. If the camera is not found, wait a few seconds, and then click Start Discovery.

In the Discovered Devices list, select the camera, and click Open. GCT now downloads the file with the
camera interface specification, which takes a few seconds. Afterward, the Discovery dialog box is closed,
and the available camera parameters are shown in the configuration widget.

If the Discovered Devices show no camera, and if you have a GigE camera, please follow the instructions
of 10 GigE with s2i transport layer or 10 GigE with Kithara transport layer.

The camera discovery is controlled by several parameters and options, which can be modified if necessary:

Disconnecting the camera

After the camera is connected, the Discovery button is replaced by a Disconnect button. Click this button to
unlink the connection. If you want to disconnect the camera while it is grabbing images, it is recommended
to stop the grabbing process completely before you click Disconnect. The disconnection progress may take
several seconds, due to the cleanup of generated temporary data in the background.

Connection and disconnection of Camera
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Connection two cameras with one PC

The latest GCT2 version does not have support for multiple cameras in one GCT2 instance. To connect
more than one camera to the PC, you need to open two instances (Windows) to connect the camera to a
PC.

If you connect two cameras to the PC and open a new instance of GCT2, you can select one camera and
connect it to the GCT2 instance. Both cameras are visible in the Discovery window. With a second GCT2
instance, you can connect the second camera.

Edit Transport Layer

The Transport Layer (TL) is used to refer to the interface such GigE (Kithara or s2i) or CoaXPress.

During the first discovery process after installation, GCT fetches the paths from the system environment
variable GENICAM_GENTL64_PATH and searches for .cti files in each of those folders. If cti transport
layer files are found and can be parsed, the camera can be detected with the corresponding transport
layer. This may take several minutes during the first discovery process.

If it is required to change the TL you can change it in the Discovery dialog window, as shown in the
previous chapter. To change the TL press the GenTL Producers button, a Producer List shows the
available TL, as shown in the image below.

To enable or disable a Transport layer, select a certain file, for example, ls_tL_gev_kithara.cti or
GEVTLS2I.cti, and click or clear the bock. The discovery process is then started using a certain Transport
layer. We recommend enabling only one transport layer.
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Modifying features

GCT allowed to modify the features in two different ways. On the one hand, the configuration panel makes
setting functions more convenient, special views show a set of related functions on which you can easily
change these parameters. On the other hand, the camera feature panel allowed to edit the parameter in the
XML-Tree.

In the Configuration panel

The view consists of four main tabs Acquisition Control, Camera Image Calibration, Pixel Processing and
Special functions. Each tab shows several subtabs.

The Acquisition Control tab, for example, show five subtabs, which permit to specify many features such as
image format and trigger settings. Some features also have additional explanation pictures.

In the camera feature panel (XML Tree)

On the left side of the GCT window, features and their values are shown in a tree structure organized in
feature groups. To show the features of a feature group, click on the arrow preceding the group name.

Modifying and showing features
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Modifying features

In the configuration panel, the information is displayed when you move the mouse pointer over the
parameter input field or the blue information icon.

Showing feature details

Feature details can be displayed in the configuration panel and in the camera feature panel.

In the Configuration panel

In the configuration panel, the information is displayed when you move the mouse pointer over the
parameter input field or the blue information icon.
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NOTICE
Irreparable damage to the camera

If the camera ist powered down during firmware update it may get into a non-
functional state. Recovery may not be possible.

The Up-/Download dialog allows you to Upload files from the PC to the Camera, for example, Camera
Package files, as well as user sets. You can also download files from the camera to the PC. Supported file
types and extensions depend on the camera type.

Uploading files to the camera

You can restore user settings, calibration files, and other file types which are previously downloaded from
the camera. 

1. In the menu bar navigate to Tools. 

2. Click Up-/Download or use the hotkey Ctrl+D.

The Update/Download wizard opens.
3. Click Select Update File and select the file
you want to upload and click Open.
4. GCT shows a warning message.
5. Check if the Type of your file corresponds to the
selected category in Update.
6. Click Start Update. 
7. GCT shows a warning message.
8. Click Yes to start the Upload.
9. Check the text in the Info Box: If the update was
successful, it contains a green confirmation
message “Update is successfully completed”.

Up-Download
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Downloading files from the camera to the PC

Firmware files, as well as user sets and other file types, can be downloaded from the camera to the PC and
saved to a file.

1. In the menu bar navigate to Tools. 

2. Click Up-/Download or use the hotkey Ctrl+D.

The Update/Download wizard opens.
1. Click Download and select your file in the drop-
down menu.
2. Click Download to.
3. Select a folder, enter a file name, and then click
Save.

Updating the firmware
1. Download firmware from the Chromasens website
or use the firmware file provided by Chromasens.

2. Note the Device Package Version of the currently
installed firmware displayed in the Device Control
feature group.

3. In the menu bar navigate to Tools. 

4. Click Up-/Download or use the hotkey Ctrl+D.
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The Update/Download wizard opens.
4. Click Select Update File and select the Firmware
Package file to upload and click Open.

5. GCT shows a warning message.
6. Check if the Update field shows the Firmware
Package file type.
7. Click Start Update. 
8. GCT shows a warning message.
9. Click Yes to start the Upload.

10. Check the text in the Info Box: If the update was
successful, it contains a green confirmation message
“Update is successfully completed”.

11. Reconnect and Restart the camera 

12. Check the Device Package Version in the Device
Control feature group to make sure that the camera
successfully booted with the new firmware.

Video description

NOTE: F i rmware Package fi le     

For allPIXA evo select the
allPIXAevo_listfile_......ini file.
For allPIXA neo select the
allPIXAneo_listfile_.....ini file.

NOTE: Time for Update

Depending on the file size, firmware upload may
take up to several minutes.

NOTE: Update Status 

If the update was unsuccessful, do not switch off
the camera, try to restore the previous state by
uploading the correct file for the previously
selected file type.
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Create a black-reference with DSNU.

1. Switch off the illumination.
2. Cover the lens with a black

or dark piece of cardboard
or plastic.
No light may reach the
sensor.

3. In the menu bar navigate
to Tools → Calibration.

4. Click Generate DSNU
Reference.

The Generate DSNU Reference
wizard opens.

5. Click Acquire image to
generate the DSNU
directly from the camera
or
click Load from Disk to
load an image from the
hard drive.

The raw image and the line plot of
the image is displayed. 

Send the calculated DSNU to the
camera: 

6. Select LUT 1 or LUT 2.
7. Click Send data to

camera.

Create a black-reference (DSNU)

NOTE: Load from
Disk

Make sure that the
image has been taken
with active image
calibration mode by
using the wizard.
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8. In the Configuration
window navigate to
Camera Image Calibration
→ DSNU/PRNU.

9. Make sure that DSNU is
enabled.
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Create a shading-reference with PRNU.

1. Place a moving white
target.
If using a stationary target,
place it slightly out of
focus.

Acquire an image:
2. In the toolbar click Acquire

a single frame 
or 
click Start grabbing, wait
until an image ist
displayed,
click Stop grabbing.

3. In the menu bar navigate
to Tools → Calibration. 

4. Click Generate PRNU
Reference.

Create a shading-reference (PRNU)
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The Generate PRNU Reference
wizard opens.

5. Click Acquire image to
generate the PRNU
directly from the camera
or
click Load from Disk to
load an image from the
hard drive.

The raw image and the line plot of
the image is displayed. 

6. Click Start 2-Click-
Selection. 

7. Click on the image to
select the ROI.

Send the calculated PRNU to the
camera: 

8. Select LUT 1 or LUT 2.
9. Click Send data to

camera.

Activate brightness and contrast:
10. Select the Activate

Brightness and contrast
checkbox.

11. Set the Contrast to 0.9.

NOTE: Load from
Disk

Make sure that the
image has been taken
with active image
calibration mode by
using the wizard.
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Each camera contains an XML file specifying the available camera features. When GCT connects to the
camera, it loads the XML file and shows the features as a tree structure.

Each feature has a visibility level. While all features are displayed for user-level Developers, many
advanced features are hidden for user-level Beginner.

The User Level is shown above the feature area. To modify the user level, click the displayed User Level,
and then click the desired level:

User level
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To show the message log, click Message Log on the View menu or click Show message log window in
the bottom right corner of the GCT window. A Message Log area is then shown below the image area:

To copy messages to the clipboard, mark the messages, right-click on the selected messages, and then
click Copy on the appearing context menu.

To copy all present messages, right-click on the Message Log area, click Select All  on the appearing
context menu, and then press Ctrl+C.

Show message log
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To open the Options dialog box, click Settings on the Start menu.

Option name
Default
value

Description

Wait for image
timeout

30000

If the next image is not received after the specified time, then it will
send a timeout.

The value can be modified. When GCT is restarted, it is set back to
30000.

Heartbeat timeout 3000
Read the value of GevHeartbeatTimeout from the camera (control
channel).

Data Stream Buffer
Count

5
Specifies the number of buffers used for each stream. The value
should be at least 2 or 3.

Ignore Image
Timeout

Not
selected

Can be selected if the acquisition process should continue despite
timeout error.

Display Corrupt
Image

Not
selected

Can be selected if an image should be displayed despite missing
data

Stops If an Error
Occurs

Not
selected

Draw All
Can be set to display every x frames, or to shut off display to reduce
CPU usage.

Enable XML feature
caching

Not
selected

So that the actual value is retrieved directly from the camera, instead
of from a cached register.

The options (except Wait for image timeout and Heartbeat timeout) are saved in GCC.ini

GCT Options
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The GCC.ini file, which is located under C:\Users\Public\Documents\Chromasens\GCT2, including the

content of producer path, producer filename, and selected producer for the discovery are already adjusted
automatically in the file GCC.ini. file. Therefore, if the discovery has already been executed, the file GCC.ini
could look as follows in the block of [DefaultProducers].

ProducerList contains the found cti transport layer files.
AdditionalSearchPath contains the additional search paths for cti files, which can be added by
clicking Add Producer Path.
SelectedProducerList contains the cti transport layer files which are selected to be applied for the
discovery process.

GCC.ini file
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GCT offers two different configurations of the GigE interface Transport Layer to connect and configure a
TKH vision group camera. The 10 GigE real-time solution with the Kithara Transport Layer (Lakesight

Tech. GEV TL, "C:\Program Files\Chromasens\GCT2\GenTL\Kithara\ls_tl_gev_kithara.cti") and the 10

GigE with the s2i Transport Layer (S2I GEV TL Interface,"C:\Program

Files\Chromasens\GCT2\GenTL\s2i\GEVTLS2I.cti").

We recommend using the Kithara real-time solution for any real-time application. In some cases, it is also
possible to use the s2i Transport Layer, but only for single link connections. For dual link connections, the
use of the Kithara Transport Layer is recommended.

10 GigE transport layer

Info

Packets lost can occur without the Kithara real-time kernel solution even with large receive buffers in
combination with different Hardware components
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Kithara real-time can provide fast image capturing with the GigE Vision standard and can achieve high
performance. Running Kithara real-time requires dedicated CPU cores. On those reserved cores, the real-
time system is booted, which, from here on, functions just like a separate RTOS while Windows retains its
full operability on the remaining CPU cores. From this point on, Windows and the real-time system run
simultaneously and parallel to each other on the same computer, without one restricting the other.

The Kithara transport layer enables communication with GigE cameras based on the Kithara software.

General Kithara Informations

Requirements 

PC: 

Kithara supports up to 48 logic cores in the system 
Kithara supports up to 125 GB RAM 
The maximum usage of dedicated CPUs is 8 (one CPU per link)
The maximum usage of network ports is 8  

A Single Link consumes 1 port 
A Dual Link consumes 3 ports (2 physical, 1 virtual port) 
This result in a maximum of 8 Single Link or 2 Dual Link cameras and 2 Single Link cameras

One dongle per PC-System is required, regardless of the number of connected cameras

Valid camera configuration: 

Using DHCP 
Using static IP address in the range of 169.254.X.X (169.254.1.202 using a subnet mask of
255.255.0.0)

Licensing

A valid software license including a USB dongle is required to use the Kithara transport layer. Don't hesitate
to get in touch with Chromasens about the information on licensing options. The license dongle is part of
the delivery for allPIXA evo DXGE cameras. 

Camera connection with Kithara Transport Layer

After the configuration of Kithara, the camera connection is working with the Kithara Transport Layer. To
connect the camera, proceed as follows:

1. Make sure that the license USB dongle is plugged in before using the Kithara Transport Layer.
2. Make sure that you configure the Kithara Transport Layer properly. The configuration is done

10 GigE with Kithara transport layer

Note

Make sure that your PC offers enough 8-lane PCIe 3.1 slots to cope with the data transmission of two cameras! For
more information see the manual of our PC (Mainboard)
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automatically during the installation of GCT. 
3. When you start GCT, the first step is to detect the camera. The Kithara TL can be used like any

other producer.

Setting up the Kithara Transport Layer 

You can Configure the Kithara Transport Layer with the Kithara Configurator on your Desktop. 

1. Plug in the license USB dongle before using the
Kithara Transport Layer.
2. Open the Generate Config for Kithara from
your desktop.
3. Read the instructions and confirm by
clicking Next.

4. Select the adapter. 

 If Kithara is going to be used with a single
cable connection, select the corresponding
adapter port in the adapter list and
clickCreate Single Link Connection.
If Kithara is going to be used with two
cables (which connect two dual ports of the
same network adapter), select the two
adapter ports in the adapter list and
click Create Dual Link Connection.

5. Click Next to confirm the configuration.

The configurator adds a file kithara_config.txt to the folder C:\Users\Public\Documents\Chromasens\GCT2,
which contains the hardware IDs of the network adapters on which Kithara will be executed. Without this
file, the Kithara transport layer is not able to detect the devices in GCT. The Kithara Configurator also adds
the dedicated CPU cores for Kithara and disables Hyper-Threading. The Kithara Configurator will prompt
the system to reboot to update the changes.

Note

If the Kithara transport layer file ls_tl_gev_kithara.cti has been selected in the Select TL Producer
dialog box, and the file kithara_config.txt in the folder C:\Users\Public\Documents\Chromasens\GCT2
has been configured, a blue Kithara window may appear for some seconds during the first camera
discovery with Kithara TL.
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Resetting network adapter driver back to Windows driver

After discovering the camera with the Kithara transport layer file, the corresponding network adapter
connections are assigned to the Kithara driver and can no longer be found in the list of normal network
adapters in the Windows Device Manager.

As shown in the following screenshot of the Windows Device Manager, the two entries of the dual port HP network adapter

(HPE Ethernet 10Gb 2-port 560SFP) are not available in the Network adapters list. Instead, they are present in the Kithara

System Devices list with the name Kithara RealTime -PCI Intel 10 GbE Network Controller.

To reset a Kithara RealTime PCI network controller:

1. Open the Generate Config for Kithara from
your desktop. 

2. Read the instructions and confirm by
clicking Next.

3.  Remove the single or dual link connection from
the list, therefore, select the connection and press
the Remove connection button.
4. Click Next to confirm the configuration.

5. Navigate to Windows Settings and click
Network & Internet.

6. Click Change adapter options.

Warning

The Kithara configuration can currently be executed once before the first use of Kithara. After Kithara
has been used at least once, the configured adapter port(s) are dedicated to Kithara and cannot be
used from within Windows unless the driver is set back manually. In the Windows Device Manager, the
network adapters can be found in the Kithara System Device section. If the cable connection for
Kithara is changed, it is required to reset the network adapter driver to the original Windows network
adapter driver (so that the device can be found under Windows) and rerun the Kithara Configurator.
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7. Right-click one of the Kithara RealTime PCI
network controllers, and then click Properties.
8. Click Configure and on the next dialog box
click the Drivers tab.
7. Click Update Driver.
8. Click Search driver on my PC and then
click Select available drivers from a list of my
PC.
9. Select the suitable adapter driver and then click
Continue.

10. After the resetting of Kithara you can find the
Network adapter in the Device manager under
Network adapters. 

Kithara_config.txt file

The kithara_config.txt contains the hardware ID of the network adapters and the configuration whether it is
a single or dual connection. The file is created by executing the Kithara Configurator. The file is stored
under: 

C:\Users\Public\Documents\Chromasens\GCT2

If only a single link is used with Kithara, this file contains the hardware ID of the chosen connection
as a single entry.
If the dual link is used with Kithara, this file contains two items from the dual connections.

Note 

After the reset of the Network adapter it is required to set up the parameter of the network adapter, therefore please
refer to  Configure the network adapter.
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The s2i transport layer does not require an additional license dongle.

Connect the camera with s2i transport layer 

1. Stat Device Discovery 

2. Press GenTL Producers and check the
GEVTLS2I.cti  file. 

3. Press OK. 

4. Press Start Discovery. 

Filter driver

The s2i transport layer offers the usage of a filter driver. A filter driver is used to get the UDP-image-data
packets before the operating system accesses them. This leads to a drastically improved error rate and
decreases the number of lost packets drastically. To configure the filter driver, go to the Configuration
widget and select the Camera Features tab, here you can check and uncheck the filter driver.

10 GigE with s2i transport layer

Note

Make sure that the parameters of your network adapter are set correctly. For more information, see Configure
the network adapter.

GCT2 manual  Vers ion 1.0.0, Date 15.09.2023

Page: 41 

https://docs.chromasens.de/v1/docs/configure-the-network-adapter-1#Set network adapter parameter


Set network adapter parameter

Automatic setting of the parameters

In the Public folder of GCT installation, a configuration script is also stored. 

For the configuration please: 

1. Turn on your camera and connect it to the PC.
2. Open the Windows command line in the
Administrator mode, therefore press Start and
type CMD into the search box. Now you can open
the CMD in the Administrator mode.

3. Copy the following command into the CMD and
press enter.

cd C:\Users\Public\Documents\Chromasens\GCT2 

4. Copy the following command into the CMD and
press enter.

runConfig10GigE.bat

5. The command line window lists all available ethernet
adapters and you can configure the network adapter by
entering a Y into the script.

6. After the configuration of the network parameter,
the script can help you to set a static IP Address of
the network adapter. We recommend disagreeing
by entering N into the window. If you want to set a
static IP Address for your network, you can answer
with Y.

Manual setting of the parameters

In contrast to the section above, this section is now oriented to the network adapters, which are not
supported by Intel, or the operating system is Win7 x64. The setup depends on the adapter manufacturer. 

Configure the network adapter

Note

This configuration of your GigE network adapters is done during the installation of GCT. You will
also need it if you want to remove the Kithara TL.

You can run this script if you use a network adapter with an Intel chipset.

Note

If an error occurs during the execution of

the script you have to configure the network

adapter manually.
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1. Navigate to Windows Settings and click Network &
Internet.

2. Click Change adapter options.

3. Right-click the Ethernet adapter that will be used to connect
the camera, and then click Properties.

4. In the network tab only enable Sphinx GigE Fi lter Driver
and Internet Protocol version 4 (TCP/IPv4). 

4. Click Configure, and then click the Advanced
tab. The available parameters may vary and are
depending on the adapter.

5. Set the following parameter. 

Attribute name (English) Attribute name (German) Value
Interrupt Moderation Interrupt-Drosselung Enabled
Jumbo packet Jumbo Packet 9014 Byte
Large-Send-Offload V2(IPv4) Large-Send-Offload V2(IPv4) Enabled
Large-Send-Offload V2(IPv6) Large-Send-Offload V2(IPv6) Enabled
Direct Cache Access Direct Cache Access Enabled
Receive Buffers Empfangsbuffer Max (e.g. 4096)
Flow control Flusssteuerung Disabled
Interrupt Moderation Rate Interrupt-Drosselungsrate Adaptive
Low Latency Interrupts Low Latency Interrupts(LLIs) Disabled
Transmit Buffers Übertragungspuffer Max (e.g.16384)
Rx and Tx from Offloading Options Rx und Tx von Offload-Optionen Enabled
Receive Side Scaling RSS (Empfangsseitige Skalierung) Enabled
RSS queues RSS-Warteschlangen 2
Log Link State Event Verbindungsereignis protokollieren disabled

Set IP address 

To connect GCT to the camera, you may need to adjust the properties of the network adapter. There are
basically three methods to configure the IP address and subnet mask of your PC and camera:

Use LLA (link-local address) autoconfiguration, this is by default always enabled.
Use a DHCP server to configure the network settings of the PC and camera, in the default factory
setting it is enabled.
Use manually assigned persistent IP addresses and subnet masks for the camera and network
adapter, in the default factory setting it is disabled.
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In typical installations, the camera is connected directly to the network adapter of the PC with the DHCP
server configuration.

Set the camera IP address with GCT

If the camera does not show up in the GCT discovery window you can set the IP-Address in GCT. 

1. Start Device Discovery in GCT.

2. Enable the Ignore Subnet check box.
If the camera now shows up but cannot be connected
(Open button is disabled), you can set the camera IP
address manually. 

3. Click the Set Camera IP  button 

4. Select the network adapter the camera is connected. 
The program will assign an IP address to the camera 

5. Click Save Configuration 

DHCP server configuration

The DHCP server configuration tries to assign different IP addresses from the Link-Local-Block
(169.254.x.x) to both the camera and network adapter automatically and set the subnet mask of both
devices to 255.255.0.0.

Configure the DHCP Mode in the Camera: 

1. Switch On and connect the camera with GCT.

2. In the Camera Feature tab navigate to -->
Transport Layer Control --> GigE Vision --> Gev
Interface Selector.

3. Switch the Gev Current IPConfiguration
DCHP  --> On.

4. Switch the Gev Current IPConfiguration
Persistent IP  --> Off.
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Configure the DHCP Mode in the Network adapter: 

1. Navigate to Windows Settings and click
Network & Internet.

2. Click Change adapter options.

3. Right-click the Ethernet adapter that will be used to
connect the camera, and then click Properties.

4. On the Networking tab select the Internet Protocol
Version 4 item and then click Properties.

5. Make sure that the Obtain anIP address
automatically check box is selected.

Persistent IP adress configuration

The persistent IP address implies that the feature Current IP Configuration Persistent IP is switched on in
the camera. 

Configure the Persistent IP Mode in the Camera: 

1. Switch On and connect the camera with GCT.
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2. In the Camera Feature tab navigate to -->
Transport Layer Control --> GigE Vision --> Gev
Interface Selector.

3. Switch the Gev Current IPConfiguration
DCHP --> Off.

4. Switch the Gev Current IPConfiguration
Persistent IP --> On.

Configure the Persistent IP MOde in the Network adapter: 

1. Navigate to Windows Settings and click Network &
Internet.

2. Click Change adapter options.

3. Right-click the Ethernet adapter that will be used to connect
the camera, and then click Properties.

4. On the Networking tab select the Internet Protocol Version 4
item and then click Properties.

5. Click Use the following IP address.
6. In the IP address field of the Network adapter specify an
address that differs from the IP address of the camera only in
the last field. When the camera IP address shown in the GCT
discovery window is 169.254.100.100, you can set the IP
address of the network adapter e.g. to 169.254.100.99.
7. At the Subnet mask enter 255.255.0.0.
8. Close the properties dialog boxes by clicking OK.

Note 

For Kithara use a static IP address in the range of
169.254.X.X (169.254.1.202 using a subnet mask of
255.255.0.0)
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SFP+ connection

If you are using the s2i Transport Layer it is required to configure the network adapter properly.
The HPE Ethernet 10Gb 2-port 560SFP+ Adapter  and Intel (X710) are configured during
installation. 

* Some manufacturers encode their cards. Those cards can only be used with the appropriate
transceivers.
Example: Intel X710 chipsets only work with Intel or Intel-configured transceivers

Network adapter

The following network adapters are tested with GCT2. The results are shown in the following table.

Vendor
Name

Type Result
S2i
TL

Kithara
TL

HPE HPE Ethernet 10Gb 2-port 560SFP+ Adapter
Fully
functional

X X

HPE * HPE Ethernet 10Gb 2-port 562SFP+ Adapter
Not
supported yet

Intel * Intel® Ethernet-Converged-Network-Adapter X710
Fully
functional X X

Myricom Myricom 2x 10GbE SFP+ low-profile NIC Only with s2i X

Myricom Myricom 1x 10GbE SFP+ low-profile NIC Only with s2i X

Mellanox
NVIDIA Mellanox MCX512A-ACAT ConnectX®-5 EN
Network adapter

Only with s2i X

Installation 

Network adapter 

HPE Ethernet 10Gb 2-port 560SFP+ Adapter

Network adapter with X550 Intel chipset

Network adapters and transceivers

Download and install the following files

Download the Wired_dirver_xx and the
Wired_PROSet_xx from the Intel
Homepage.

Download and install the following files

Download the Wired_dirver_xx and the
Wired_PROSet_xx from the Intel
Homepage.
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Network adapter with X710 Intel chipset

Transceiver

The following transceivers are tested with the allPIXA evo camera and the network adapters.

Vendor
Name

Type Comment
Camera
side

Network
adapter
side

Finisar
FTLX8574D3BCL

Class 1 21CFR1040:10
X X

FS SFP-10GSR-85 X X

FS
Intel E10GSFPSRX Compatible 10GBASE-
SR SFP+ 850nm 300m DOM Duplex LC
MMF Transceiver Module

Recommended for
Network adapters that
are marked with *

X

RJ45 connection 

Network adapter 

The following network adapters are tested with GCT2. The results are shown in the following table.

Vendor name Type Result s2i TL Kithara TL 

Broadcom
P210TP - 2 x 10GBASE-T
PCIe NIC

Fully functional X

Installation 

1. Download the driver file and follow the
installation instructions.

Download and install the following files

Download the Release_xx from the Intel
Homepage.

Download

For the Broadcom Network adapter "P210TP - 2 x

10GBASE-T PCIe NIC", you can find the download

files here. 
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2. Set Jumbopacket Size 
Open the Device Manager
Right- c li c k      one ethernet connection of
the Gigabit Ethernet network card, and
then click Properties  
Click Conf igure  , and then click the
Advanc ed   tab
Set Jumbo packet to 9014 byte 

Setup

1. Open the camera with GCT

2. In GCT navigate to DS0

3. Enable the Enable Packet Resend feature
4. Set the Packet Resend Count to 255 (or 99)
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The following CXP frame grabbers are tested with GCT2. The results are shown in the following table.

Manufacturer Type Result Comment

Euresys
CoaxLink Quad
CXP12

Fully
functional

Matrox Rapixo CXP
Known
Bugs

Updating the image width causes a GCT crash, a
restart of GCT is necessary, No support of RGBa8
images

Basler
CXP-12
Interface Card
4C

Fully
functional

Bitflow CYTON CXP4 Fully
functional

Tested frame grabbers
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If you want to use two cameras with one frame grabber, you may have to configure the frame grabber (see
frame grabber manual). Once it is configured correctly, you can connect the cameras as described in
chapter Connection and disconnection of Camera

Connection two cameras with one frame grabber
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Configure CXP version

The data transfer rate depends on the configured CXP standard version. This option can be set with the
parameter "Cxp version used" as shown in the following figure. We recommend using the version
CSP_Version_2_0. The CSP standard 1.0 supports a data rate of 6.26 Gbps, the CXP standard 2.0
supports a data rate of 12.5 Gbps per cxp cable.

Link configuration

The link configuration defines how many CoaXPress cables are connected to the camera and the data
transfer rate. The number of connected CoaXPress cables are assigned with the Xn. For example, a X2
means that two cables are connected to the camera. The data transfer rate per connected cable is defined
with the first number in the selectable cxp link configuration CXPt_Xn.

The following table shows the link configuration parameters and there corresponding data rate (for CXP
Version 2.0). The data rate refers to one connected CXP cable X1. The data rate increases with additional
connected CXP cable. CXP12_X2, for example, has a data rate of 25 Gbps.

Link configuration Data rate per link Xn in Gbps
CXP1_Xn 1.25
CXP2_Xn 2.50
CXP3_Xn 3.125
CXP5_Xn 5.00
CXP6_Xn 6.25
CXP10_Xn 10.00
CXP12_Xn 12.5

CXP link configuration

GCT2 manual  Vers ion 1.0.0, Date 15.09.2023

Page: 52 



GCT2 manual  Vers ion 1.0.0, Date 15.09.2023

Page: 53 



The Chromasens GenICam SDK (CSGenICam SDK) is an optional part of the GCT software package. It
can be seen as an abstraction layer above the GenICam GenApi and GenTL interfaces, as shown in
graphic below:

It permits to write applications against the CSGenICam interface. The CSGenICam interface provides a set
of convenience functions and additional functionalities specific to Chromasens cameras. As an example, it
adds functions that permit to perform file transfers from/to the device. It has a slightly simplified interface
when compared to the more abstract GenApi and GenTL producer libraries.

For more information on how to use the SDK, including a complete API reference, refer to the SDK
documentation.

https://chromasens.de/de/software

Documentation

SDK – CSGenICam
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The GCT installer provides a performance test tool. The tool allowed you to analyze the performance of your camera

connection. 

On your desktop, you can find a direct link to the performance test, therefore double-cli ck   the desktop link

"Testperformance GCT2".

The folder provides three different .bat files. These files are predefined examples to run the performance test. 

Name  Description

performanceTestCompatHelp.bat
Opens the Help dialog of the performance test
tool 

runPerformanceTestCSIGeneric.bat
Opens a generic configuration of the performance
test tool, can be used for CXP and Gige Cameras 

runPerformanceTestCSIwithKithara.bat
Opens the performance test tool for
Kithara configured cameras 

runPerformanceTestCSIwiths2i.bat
Opens the performance test tool for S2I
configured cameras 

Parameter description 
The program has the following adjustable parameters:

Parameter  Entries  Description

--checkImageConsistency None, GreyHorizontalRamp or
GreyHorizontalRampMoving

Method for checking error proune
images

--checkImageConsistencyOption STSISDComplete or STSISD
Option for checking error proune
images

--deviceSelection  auto or manual
"auto" selects the first visible
device, "manual" you can select
the device 

--height  Height in pixel

--help Performance tool options

--line_time_step_width
Number of microseconds to
increase from one test run to the
next

--pixelFormat  RGB8, Mono8.... GeniCam SFNC Pixel Format

--reportFileDir Option for setting directory of the
written report file

--ring_buffer_count Number of used frame buffers

--single_test_duration Duration in seconds for a single
integration time

--start_line_time  Line time to start with in us.

--stop_line_time When this line time is reached, the
test will be stopped.

Performance Test

Performance Test tool folder 

C:\Users\Public\Documents\Chromasens\GCT2\performanceTest
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--use_filter_driver 1 and 0 1 for on or 0 for off, default off

--width Width in pixel

Example of a command line:

PerformanceTest.exe --use_filter_driver 1 --single_test_duration 3 --start_line_time 60 --
line_time_step_width 3 --stop_line_time 65 --pixelFormat RGB8 --checkImageConsistency
GreyHorizontalRamp

This means the camera uses RGB8 as image format, starts with an acquisition line time of 60 microseconds (us),

stops after 65 us, and the step is 3 us. With each acquisition line time, the test of each different line time will take 3

seconds. The filter driver for the S2I transportlayer is set to "on".  An image consistency check is done with the

"GreyHorizontalRamp". The running program can be stopped by pressing any key.

Results and Output

The output of the Performance Test Tool is shown in the command line window and in the Test Reports folder. 

Parameter  Description 
Duration [s] Acquiring time in seconds 
Line/Frame Time [us] Set line time in microseconds 
Acquired Acquired frames 
Dropped Dropped frames 

Corrupted (N/Min/Max)

Number of corrupted pixels N = corrupted images,
Min = Minimum number of corrupted pixels in one
image, Max = Maximum number of corrupted pixels
in one image 

Packets OK Number of transmitted packets without an error
Packets Error Number of transmitted packets with an error
First Frame Packets Error Packet error in the first frame 
GBit/s Transmission rate 

*(-1 means that this method was not used for this test) 

Test Reports Folder 

C:\Users\Public\Documents\Chromasens\GCT2\performanceTest\TestReports
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No camera is found during discovery

Make sure that the license USB dongle is plugged in. Also make sure to configure the Kithara transport
layer before use by following the steps described in the section xx

Discovery takes a long time to finish

It may happen that the discovery takes a long time to finish its process without detecting the camera, even
though the system is configured properly. In such cases, restart the system and try again. If the Kithara
Transport layer is used to detect the camera, run the Kithara Configurator application again to set all the
Kithara-related parameters correctly.

Troubleshooting with Kithara transport layer

GCT2 manual  Vers ion 1.0.0, Date 15.09.2023

Page: 59 



Sometimes during image grabbing, there comes no image from the camera, and the message log shows
GEV_TIMEOUT_ERROR in the bottom area. This can be caused by following reasons.

Trigger mode not set correctly

Trigger source: If there is no explicit trigger available and the camera should run in “free-running” mode, but
the value of trigger source does not correspond to this mode, then GCT will return
“GEV_TIMEOUT_ERROR” and cannot grab images.

Filter driver not installed properly (only for 10GiGE without Kithara)

GCT can use the filter driver developed by s2i. If the filter driver should be used for the grabbing process, it
must be installed and enabled correctly beforehand in the adapter settings.
To check the adapter settings, go to Start menu -> Settings -> Network & Internet. On the Settings window,
click Change adapter options. A new dialog box opens with a list of network connections. Right-click the
corresponding GigE Ethernet connection for the camera and then click choose Properties. If a teaming
group is used, then right-click the teaming group and choose its attributes. Ensure that s2i GigE-Vision
Filter Driver is selected and that the version is correct.

“Secure Boot” not disabled in BIOS settings (only for 10GiGEwithout Kithara)

If the filter driver is installed properly and can also be detected, but
“GEV_STATUS_DRIVER_READ_ERROR” appears during grabbing, it could be due to Secure Boot in the
BIOS settings. In this case refer to section 3.4.2.

Firewall is not completely allowed for GCT

Data transfer between camera and PC requires firewall allowance. Normally, the firewall rule is exclusively
allowed for GCT automatically after installation.
To verify the firewall rule:

1. On the Window Start menu, click Settings-> Update & Security -> Windows Security -> Firewall &
network protection.

2. Click Advanced settings and highlight Inbound Rules in the left panel.
3. Find the rule name GCT2_x64, open its properties, and ensure that the firewall rule is allowed for

all types: domain, private, and public.

Reboot

If GEV_TIMEOUT_ERROR occurs only if the filter driver is activated, you can reboot your PC to resolve
unknown conflicts in the hardware.

Possible reasons for GEV_TIMEOUT_ERROR
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